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Practical No-01

• Name of Practical -: Computer Orgaisation
• Aim:- Block Diagram of Computer-

• Elements of Digital Computer %& 

1. Central Processing unit CPU

2. Input Device

3. Output Device

The architecture of computers differs from
one system model to another However basic
organization remains the same for all computer
system. The following figure shows a block
diagrame of basic computer organization.
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BLOCK DIAGRAM OF COMPUTER
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All computer perform the following basic operations for converting raw input 
data into usefull information and presenting it to the user.

Five basic operations performed by computer are

1. Inputting

2. Storing

3. Processing

4. Outputting

5. controlling

Practical No-02
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INPUT UNIT

Computers need to receive data and instruction in order to Solve
Any Problem. Therefore we need to input the data and Instructions
into the computers. The input unit consists of one or more input
devices.

• Keyboard is the one of the most commonly used input device.
Other commonly used input devices are the mouse, floppy disk
drive, magnetic tape, etc.

All the input devices perform the following functions.

•Accept the data and instructions from the outside world.

•Convert it to a form that the computer can understand.

•Supply the converted data to the computer system for further
processing.
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Storage Unit
• The storage unit of the computer holds data and instructions that are entered 

through the input unit, before they are processed. 

• It preserves the intermediate and final results before these are sent to the 

output devices. 

• It also saves the data for the later use. 

The various storage devices of a computer system are divided into two 

categories.

1. Primary Storage: Stores and provides very fast. 

• This memory is generally used to hold the program being currently executed in 

the computer, the data being received from the input unit, the intermediate and 

final results of the program. 

• The primary memory is temporary in nature. The data is lost, when the 

computer is switched off. 
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2. Secondary Storage:

•Secondary storage is used like an archive. 

•It stores several programs, documents, data bases etc. 

•The programs that you run on the computer are first transferred to the primary 
memory before it is actually run. 

•Whenever the results are saved, again they get stored in the secondary memory. 

•The secondary memory is slower and cheaper than the primary memory. 

•Some of the commonly used secondary memory devices are Hard disk, CD, etc.,

In order to store the data permanently, the data has to be transferred to the 
secondary memory.
The cost of the primary storage is more compared to the secondary storage. 
Therefore most computers have limited primary storage capacity.
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Memory Size

• All digital computers use the binary system, i.e. 0’s and 1’s. Each 

character or a number is represented by an 8 bit code.

The set of 8 bits is called a byte.

A character occupies 1 byte space.

A numeric occupies 2 byte space.

Byte is the space occupied in the memory.

• The size of the primary storage is specified in KB (Kilobytes) or MB 

(Megabyte). One KB is equal to 1024 bytes and one MB is equal to 

1000KB. 

• The size of the primary storage in a typical PC usually starts at 16MB.

• PCs having 32 MB, 48MB, 128 MB, 256MB memory are quite common.
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Output Unit

The output unit of a computer provides the information and 

results of a computation to outside world. 

• Printers, Visual Display Unit (VDU) are the commonly used output 

devices. 

Other commonly used output devices are 

 floppy disk drive,

 hard disk drive, 

 magnetic tape drive.
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Arithmetic Logical Unit

• All calculations are performed in the Arithmetic Logic 
Unit (ALU) of the computer. 

• It also does comparison and takes decision. 

• The ALU can perform basic operations such as addition, 
subtraction, multiplication, division, etc and does logic 
operations like, >, <, =, ‘etc.

• Whenever calculations are required, the control unit
transfers the data from storage unit to ALU, once the
computations are done, the results are transferred to
the storage unit by the control unit and then it is send
to the output unit for displaying results.
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Control Unit
• It controls all other units in the computer.

• The control unit instructs the input unit, where
to store the data after receiving it from the user.

• It controls the flow of data and instructions
from the storage unit to ALU.

• It also controls the flow of results from the ALU
to the storage unit.

• The control unit is generally referred as the
central nervous system of the computer that
control and synchronizes its working.
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Central Processing Unit

• The control unit and ALU of the computer are together
known as the Central Processing Unit (CPU).

• The CPU is like brain performs the following functions:

• It performs all calculations.

• It takes all decisions.

• It controls all units of the computer.

• A PC may have CPU-IC such as Intel 8088, 80286, 80386,

80486, Celeron, Pentium, Pentium Pro, Pentium II, Pentium

III, Pentium IV, Dual Core, and AMD etc .
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INPUT OUTPUT DEVICES

A computer system needs to communicate with

its external environment its user). The

Input/output devices provide this capability to a

computer system.

Practical No-03
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INPUT DEVICE
• Input devices are used to enter data from outside 

world into primary storage & output devices supply 
the result of processing from primary storage to 
users.

• Input device is any peripheral (piece of computer 
h/w equipment) used to provide data & control 
signals to an  information processing system. 
Input/output devices make up the h/w interface 
between a computer .
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The most common input devices are following.

1. Keyboard

2. Mouse

3. Scanner

4. Joystick

Practical No-03

Presented by. Dr.Ronil K. Ahale



KEYBOARD
• The keyboard is the main input device for computers. For 

instance, boot up a computer without a keyboard and it 

stops, warning the user that no keyboard is attached.

• The keyboard is the only tool available at the command 

prompt, so it is a necessity for a computer. 

• It is also used in almost every application like spreadsheets, 

email, word processing documents and coding. 

Practical No-03
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. 

• It is possible to interact with most computers solely 

through the keyboard, without even a mouse, because 

they are usually the default input device. Touch screens 

may eventually overcome the keyboard as well, by 

providing an onscreen keyboard to save space. 

• The keyboard is the most common input device. It is 

almost unheard of for a computer to be without some form 

of keyboard, be it a full QWERTY keyboard or a smaller 

number pad, such as those found on a cell phone

Practical No-03
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Mice and other Pointing devices
• Other than the keyboard, mice are the most common type of 

input device. 
• Nearly every computer has one, and they make navigating the 

screen much easier than trying to use just a keyboard.
• Mice usually use a ball, light, or a laser to track movement. 
• Similar peripherals, such as a touch screen or laptop's touchpad, 

trackballs, graphics tablets, and even joysticks are “pointing” 
input devices.

• Touch screens are becoming an increasingly popular pointing 
device, and someday may replace mice altogether. 

Practical No-03
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scanner
• Scanners allow information such as a photo or text to be 

input into a computer.

• Scanners are usually either A4 size (flatbed), as shown 

below, or hand-held to scan a much smaller area. 

• If text is to be scanned, you would use an Optical Character 

Recognition (OCR) program to recognize the printed text 

and then convert it to a digital text file that can be accessed 

using a computer.
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CD-ROM

• Short for Compact Disc-Read Only Memory, CD-
ROM drives are CD players inside computers that 
can have speeds in the range from 1x and 
beyond, and have the capability of playing audio 
CDs and computer data CDs. 

Practical No-03
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• Below is a picture of the front and back of a 
standard CD-ROM drive. 
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Output device 

• An output device is any piece of computer 
hardware equipment used to communicate the 
results of data processing carried out by an 
information processing system (such as a 
computer) to the outside world.

Practical No-03

Presented by. Dr.Ronil K. Ahale



• In computing, input/output, or I/O, refers to the 
communication between an information processing 
system (such as a computer), and the outside world.

• Inputs are the signals or data sent to the system, and 
outputs are the signals or data sent by the system to the 
outside.

Practical No-03
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Examples of output devices:

• Speaker

• Headphones

• Screen (Monitor)

• Printer

Practical No-03
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speaker

• Computer speakers, or multimedia speakers, are speakers 
external to a computer, that disable the lower fidelity built-in 
speaker.

• They often have a low-power internal amplifier. 

• Computer speakers range widely in quality and in price.

• The computer speakers typically packaged with computer systems 
are small, plastic, and have mediocre sound quality. Some 
computer speakers have equalization features such as bass and 
treble 

Practical No-03
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Headphones
• Headphones are a pair of small loudspeakers, or less 

commonly a single speaker, with a way of holding them close 
to a user's ears and a means of connecting them to a signal 
source such as an audio amplifier, radio or CD player.

• They are also known as stereo phones, headsets.

• The in-ear versions are known as earphones or ear buds. 

• In the context of telecommunication, the term headset is used 
to describe a combination of headphone and microphone used 
for two-way communication, for example with a telephone.

Practical No-03
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Monitor
• A Monitor or Display (sometimes called a visual 

display unit) is an electronic visual display for 
computers.

• The monitor comprises the display device, 
circuitry, and an enclosure.

• The display device in modern monitors is 
typically a thin film transistor liquid crystal display 
(TFT-LCD) thin panel, while older monitors use a 
cathode ray tube about as deep as the screen 
size.

Practical No-03
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Examples of Output Devices

• Monitor

This is the most common output device.

ICT Tools: Output Devices

Practical No-03
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Screen Features

• Size
Desktop screens are usually 14 – 19 inches by diagonal 
measurement. (This is how TV screens are measured, too.) Larger 
sizes are available, at a significantly higher cost.

• Resolution
Determines how clear and detailed the image is. 
Pictures on a screen are made up of tiny dots. 
1 dot on screen = 1 pixel. The more pixels per inch, the clearer and 
more detailed the picture.

ICT Tools: Output Devices
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Type of Screens

• Monochrome
One colour text on single colour background, i.e. white letters on blue, or 
green characters on black.

• Colour
Various colours can be displayed.

• Liquid Crystal Display
(LCD)
Used in laptops especially.

• Plasma Screens
Used for very large screens and some laptops.

ICT Tools: Output Devices
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Printers

Impact Printers Non-Impact Printers

Daisy

wheel

Dot-

Matrix
Inkjet Thermal Laser
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“Dot Matrix Printer”

• The term dot matrix refers to 
the process of placing dots to 
form an image. 

• Its speed is usually 30 to 550 
characters per second (cps). 

• This is the cheapest and the 
most noisy printer and has a 
low print quality. Dot Matrix 
were 1st introduced by 
Centronics in 1970.

Practical No-03
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“Ink-Jet Printer”
• It is a non-impact printer 

producing a high quality 
print. A standard Inkjet 
printer has a resolution of 
300dpi. Newer models 
have further improved dpi. 
Inkjet printers were 
introduced in the later half 
of 1980s and are very 
popular owing to their 
extra-ordinary 
performance.

Practical No-03
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“Laser Printer”

• Laser printers use very 
advanced technology and 
produce a high quality 
output. Laser printers can 
also produce high quality 
graphics images.

• Resolution is 600 to 
1200dpi.

Practical No-03
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“Multi-function printer”

• A multi function printer 
abbreviated as MFP is an all 
purpose device that prints, 
faxes, copies and scans. A 
single multi function printer 
can replace several bulky 
devices. These printers use 
inkjet technology and 
provide high quality print 
but at slow speed.
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Microsoft Word 2007
Introduction to Word Processors
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What is Microsoft Word 2007?
• Microsoft Word 2007 is a word 

processor created by Microsoft, and is 
included in the Microsoft Office 2007 
software suite.

Practical No-04
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Starting Microsoft Word
• You may start Microsoft Word by 

locating the Microsoft Office shortcut 
folder, and selecting the Microsoft 
Word shortcut.

• Note: The location of this shortcut will 
vary depending upon your chosen 
configuration and installation settings.  
However, it will most commonly be 
located in a “Microsoft Office” folder 
created during the program 
installation.

Practical No-04
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Getting Started with Word Processors 

• Word processors 
offer you the 
flexibility to format 
documents by 
making changes to 
the font, the page 
layout, and the page 
style.

Practical No-04
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Getting Started with Word Processors
You can open Microsoft Word by clicking on the desktop icon…

… or by clicking the START button.

Practical No-04
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Getting Started with Word Processors

When you see the cursor blinking, you are ready to type. 
Otherwise, use your mouse to click anywhere on the white part 
of the page.

Practical No-04
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Lesson Objectives

After completing this lesson, you will be able to:

• Perform basic tasks in a word processor.

• Edit and format text.

• Work with tables and pictures.

• Work with language tools.

Practical No-04
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Navigating within a Document

• Use your mouse to click anywhere that 

you have typed text.

• You can use the arrow keys on your 

keyboard to move the cursor vertically or 

horizontally.

• The HOME key moves the cursor to the 

beginning of the line.

• The END key will take it to the end of the 

line.
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Saving a File
To save the document, click the Save button on the Quick Access Toolbar or 

click on the Office Button to choose how to save the file.
Office Button Quick Access Toolbar

Practical No-05
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Opening an Existing File

On the Standard toolbar, 
click the Open button.

In the Open dialog box, 
double-click the name of 
the document you want to 
open.

Practical No-05
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Printing Your File

• To print out your document 
click on the Office Button, 
and then click Print. 

• This prints one copy of your 
file using the default 
settings.

• When you need to, you can 
modify the settings of your 
print job in the Print dialog 
box.
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Editing and Formatting Text 

• Advanced word processors include special tools that help you 
easily edit and format documents. 

• Word processors can: 

– cut, copy, and paste text

– undo and redo actions

– justify or re-align text

– change font parameters

– change paragraph spacing 

– various other editing and formatting functions.

Practical No-05
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Copy + Paste

1. Select
Hold down the left mouse button and drag  the cursor  OR
Hold down SHIFT and use the arrow keys on the keyboard.

1. Copy
You can find the Copy and Paste commands under the Home 
Tab.

1. Paste
You can also copy and paste by clicking with the 
right mouse button on a word you have selected
to pull up a shortcut menu.

Practical No-05
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Cut + Paste

Using Cut + Paste is like moving text from 
one location to a new one.

The cut command is located :

• in the Home Tab 

• or in a shortcut menu when you right-
click on a selected word

Practical No-05
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Formatting Text
In the Font dialog box, you can 
make changes to the type, style, 
size, and color of font used in the 

document.

Size
Font

You  can change the “handwriting” 
of your text.

Font style
Put a word in bold or italics for emphasis.

Effects
Will let you add underlining, shadows, or 
details like strikethrough.

Practical No-06
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Formatting Text

Many of these text options 
can also be found on your 
Home Ribbon in the Font 
Group.

Font Size Color
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Alignment

You can specify the arrangement of objects, 
text, and graphics, in predetermined positions 
using the alignment settings. 

You can align the selected text to the left, 
right, or center by using the left, right, and 
center alignment buttons.
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Bullets and Numbering

You can use the bullet or numbering options to 
organize information into lists.

Bullets Numbering

• Aardvark

• Butterfly

• Cactus

• Daffodil

1. Aardvark

2. Butterfly

3. Cactus

4. Daffodil
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Indenting and Spacing

Use indentation to

offset text away from

the margin or bring it

closer again. 
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Undoing Mistakes

Sometimes, you want to reverse the last 
action you performed. For this, you can use 
the Undo button: 

Similarly, you can use the Redo button to 
repeat the last action:
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Open one word document, navigate to the "Insert" tab menu on the Ribbon of
Microsoft Word 2007/2010/2013, under the Header & Footer options, you can easily
see the "Footer" item at the middle. A Built-In dialog will appear by clicking Footer.

Practical No-07Practical No-07
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Using Language Tools

Advanced word processors, such as 
Word, can automatically detect the 
language of the typed text and then 
use the spelling dictionary, grammar 
checker, and punctuation rules for 
that language.

Language tools are a convenient way 
to perform certain tasks 
automatically as you type, such as 
checking spelling and grammar.
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Spelling and Grammar Check

• Wavy red lines=spelling 
errors

• Wavy green 
lines=grammatical mistakes

• You can check the spelling 
and grammar of the entire 
document by clicking the 
Spelling and Grammar 
Button on the Review Tab.

Practical No-07
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Spelling and Grammar Check

• Spelling suggestions

• Change All

• AutoCorrect

• Grammar suggestions

• Custom dictionary

• Ignoring instances

Practical No-07
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The Thesaurus feature in 
Word lets you find 
alternatives for a word or 
phrase.

The Thesaurus Button lets 
you search for a word and 
presents a list of suggestions 
you can choose from. 

Language Tools: Thesaurus
Practical No-07
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Inserting Table

• Perfrom the following step to draw a table.

• click th table button present in the insert tab and

select drow table from the drop-down line list

mouse pointer cange in to pencil.

• Drag the pencil to drow table borders,rows and

colum when you are finshed drowing the table

press the ESC key.
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Tables and Pictures
Practical No-08
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Tables and Pictures
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Tables and Pictures
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Tables and Pictures
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Page Layout
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•Click the Menus tab; 

•Click the File drop down menu; 

•Click the Prepare item; 

•Then you will view the Properties item. 

This Properties item will add the Document0  

Properties pane above Word workspace. 
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Questions
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